
    

Simulation d’antennes imprimées avec ADS 
 

L’objectif de ce tp est d’étudier quelques fonctionnalités du simulateur électromagnétique 
Momentum d’ADS. Nous allons nous intéresser à la conception d’antenne imprimées, ici de 
forme carrée.  
Attention les résultats donnés dans ce TP sont légèrement différent de ce que vous allez 
obtenir ! 
 

1- Simulation d’un patch résonnant à 2 GHz 

Lancer ADS (choisir les unités en mm) et ouvrir un nouveau projet. 
 

Dans la fenêtre schematic , cliquer sur 
Tlines-Microstrip et placer un substrat qui 
aura les caractéristiques suivantes : 
permittivité =2.62 et épaisseur égale à 
0.762 mm (les autres caractéristiques 
restent inchangées). En cas de doute 
cliquer sur Help. 

 

Placer ensuite un morceau de ligne de transmission circuit ouvert MLOC de largeur et de 
longueur égale à 45.5 mm., puis une ligne microruban MLIN (largeur 2.097 et de longeur 
2 mm, c’est une ligne d’impédance caractéristique 50 Ohms), connectez les entre elles. 
Connectez ensuite MLIN à un port à un port. Sauvegarder ce design dans Patch seul. 

Nous allons maintenant générer le Layout (la représentation physique de notre antenne) 

Cliquer sur Layout et Generate/Update Layout (voir ci-dessous) 
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Et cliquer deux fois sur OK pour voir apparaître dans la fenêtre layout votre antenne. 

Nous allons maintenant définir les paramètres de la simulation électromagnétique. Cliquer sur 
Momentum, >  Substrate > Update From Schematic. Vérifier que la configuration est correcte en 
cliquant sur Momentum, >  Substrate > Create/Modify. 

 

 

Calculer les fonction de substrat entre 1.9 et 2.1 GHz. (Momentum, >  Substrate > 
Precompute). On calcule ici les fonction de Green dans le substrat (voir annexe b). 

 

Passons à la définition du maillage, toujours dans le même menu, vous cliquez sur Mesh 
> Setup. Nous allons uniquement nous intéresser au menu global. 

La fréquence de maillage (fréquence haute) sera 2.1 GHz, nous choisirons des cellules de 
largeur 1/20 de longueur d’onde. Les autres paramètres ne seront pas modifiés. 

Generer le maillage : Mesh > Precompute.  

 

Enfin, nous allons donner les paramètres de calcul donnés dans la figure suivante dans le 
menu Momentum > Simulation > S-Parameters… 
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Cliquer sur Apply et vérifier que vos paramètres ont bien été transmis dans le Frequency 
Plans puis lancer la simulation avec Simulate. 

A la fin de la simulation une fenêtre résultat va s’ouvrir. 
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 Il faut calculer d’autres points pour visualiser la résonance de l’antenne ! Modifier la 
fenêtre simulation en divisant le pas en fréquence en 4 et activez la case Reuse files from 
the previous simulation. Relancer la simulation. 

Pour avoir la valeur de l’impédance d’entrée, dans la fenêtre résultats cliquer sur Eqn à 
gauche et taper l’équation suivante : 

 

Enfin cliquer sur Liste (1234 5678) puis sur advanced et taper Zin. 

 

Conclusion sur la valeur de l’impédance d’entrée à la résonance ? 
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2- Simulation d’un patch adapté à 2 GHz 

Les résultats précédents montrent qu’il faut adapté le patch. Nous allons utiliser une ligne 
quart d’onde pour cette adaptation. 

Dans un premier temps, allez dans la fenêtre schematic et sauvegarder le design dans un autre 
fichier par exemple patchad. 

L’impédance d’entrée est en réalité de 410 Ohms. 

Nous allons utilisé l’outils LineCalc pour calculer ce quart-d’onde. (Tools > LineCalc). 

 

Il faut entrer l’impédance que vous voulez obtenir (et les caractéristiques du substrat et le type de 
ligne pour avoir les dimensions de la ligne) puis cliquer sur Synthesize pour avoir la largeur de la 
ligne et la permittivité effective. 

L’impédance d’entrée de l’ensemble doit être de 50 Ohms, l’impédance de la ligne quart d’onde 
sera donc de Zpatch*50 . 

Ajoutez dans la schematic la ligne correspondant au quart d’onde, sauvegardez et générez le 
nouveau layout … 

Visualiser les diagrammes de rayonnement et les courants. Commentez ? 
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3- Simulation de deux patchs adaptés à 2 GHz 

 
A partir de ce design vous pouvez étudier le couplage entre les antennes en fonction de la 

distance séparant ces deux antennes. On peut notamment voir l’influence sur l’impédance 
d’entrée et sur les diagramme du couplage. (ci dessous les deux antennes sont séparées de 5.2 
mm) 
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a. Autres exemples de simulation. 

 Vous trouverez dans les projets suivants d’autres réalisations qui ont été simulées avec ADS/ 
Momentum. 

Projet Biba 

Projet Fractale 

Projet AntSat 

… 
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Annexe : ADS/Momentum 
 

 
Momentum is based on a numerical discretization technique called the method of 

moments. This technique is used to solve Maxwell's electromagnetic equations for planar 
structures embedded in a multilayered dielectric substrate. The simulation modes available 
in Momentum (microwave and RF) are both based on this technique, but use different 
technologies to achieve their results.  

Momentum uses specific steps to achieve solutions. The technology used by each simulation 
mode varies slightly in each step. In Momentum's microwave mode, the planar metallization 
(strip, via) and aperture (slot) patterns in the signal layers are meshed using rectangular 
and triangular cells. Momentum RF mode generates a mesh of polygonal cells. The unknown 
electric (strip, via) and magnetic (slot) surface currents are discretized using rooftop 
expansion functions defined over the cells in the mesh. In Momentum RF, rooftop functions 
are regrouped in star and loop functions to eliminate low-frequency breakdown. This 
discretization process transforms the electromagnetic equations into an equivalent network 
model of self and mutual inductive and capacitive elements. The microwave mode uses 
fullwave Green's functions resulting in L and C elements that are complex and frequency 
dependent. The RF mode uses quasi-static functions resulting in L and C elements that are 
real and frequency independent.  

The sources applied at the ports of the circuit yield the excitations in the equivalent network 
model. The currents in the equivalent network are the unknown amplitudes of the rooftop 
expansion functions. Solving the equivalent network for a number of independent excitation 
states yields the unknown current amplitudes. A port calibration process is used to calculate 
the S-parameter data of the circuit from the current solution.  

The following sections in this chapter contain more information about:  

• The method of moments technology  

• The Momentum solution process  

• Special simulation topics  

• Considerations and software limitations  
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The Method of Moments Technology 
 

 
The method of moments (MoM) technique is based upon the work of R.F. Harrington, an 
electrical engineer who worked extensively on the method an applied it to electromagnetic 
field problems, in the beginning of the1960's. It is based on older theory which uses 
weighted residuals and variational calculus.  
In the method of moments, prior to the discretization, Maxwell's electromagnetic equations 
are transformed into integral equations. These follow from the definition of suitable electric 
and magnetic Green's functions in the multilayered substrate. In Momentum, a mixed 
potential integral equation (MPIE) formulation is used. This formulation expresses the 
electric and magnetic field as a combination of a vector and a scalar potential. The 
unknowns are the electric and magnetic surface currents flowing in the planar circuit.  
Using notations from linear algebra, we can write the mixed potential integral equation in 
very general form as a linear integral operator equation:  

(1)  
Here, J(r) represents the unknown surface currents and E(r) the known excitation of the 
problem. The Green's dyadic of the layered medium acts as the integral kernel. The 
unknown surface currents are discretized by meshing the planar metallization patterns and 
applying an expansion in a finite number of subsectional basis functions B1(r), ..., BN(r):  

(2)  
The standard basis functions used in planar EM simulators are the subsectional rooftop 
functions defined over the rectangular and triangular cells in the mesh. Each rooftop is 
associated with one edge of the mesh and represents a current with constant density flowing 
through that edge (Figure A-1). The unknown amplitudes Ij, j=1,..,N of the basis function 
expansion determine the currents flowing through all edges of the mesh. 
 

 
 
 

Figure A-1. Discretization of the surface  
currents using rooftop basis functions.  
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The integral equation (1) is discretized by inserting the rooftop expansion (2) of the 
currents. By applying the Galerkin testing procedure, that is, by testing the integral equation 
using test functions identical to the basis functions, the continuous integral equation (1) is 
transformed into a discrete matrix equation:  
for i=1,...,N  

(3)  
with  

(4)  

(5)  
The left hand side matrix [Z] is called the interaction matrix, as each element in this matrix 
describes the electromagnetic interaction between two rooftop basis functions. The 
dimension N of [Z] is equal to the number of basis functions. The right-hand side vector [V] 
represents the discretized contribution of the excitations applied at the ports of the circuit.  
The surface currents contribute to the electromagnetic field in the circuit by means of the 
Green's dyadic of the layer stack. In the MPIE formulation, this Green's dyadic is 
decomposed into a contribution from the vector potential A(r) and a contribution from the 
scalar potential V(r):  

(6)  
The scalar potential originates from the dynamic surface charge distribution derived from the 
surface currents and is related to the vector potential through the Lorentz gauge.  
By substituting the expression (6) for the Green's dyadic in the expression (4) for the 
interaction matrix elements, yields the following form:  

(7)  
with 

(8)  

(9)  
This allows the interaction matrix equation to be given a physical interpretation by 
constructing an equivalent network model (Figure A-2). In this network, the nodes 
correspond to the cells in the mesh and hold the cell charges. Each cell corresponds to a 
capacitor to the ground. All nodes are connected with branches which carry the current 
flowing through the edges of the cells. Each branch has in inductor representing the 
magnetic self coupling of the associated current basis function. All capacitors and inductors 
in the network are complex, frequency dependent and mutually coupled, as all basis 
functions interact electrically and magnetically (Figure A-3). The ground in this equivalent 
network corresponds with the potential at the infinite metallization layers taken up in the 
layer stack. In the absence of infinite metallization layers, the ground corresponds with the 
sphere at infinity. The method of moments interaction matrix equation follows from applying 
the Kirchoff voltage laws in the equivalent network. The currents in the network follow from 
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the solution of the matrix equation and represent the amplitudes of the basis 

functions.   
Figure A-2. The equivalent circuit is built by replacing each  

cell in the mesh with a capacitor to the ground reference and  
inductors to the neighboring cells.  

 
Figure A-3. Equivalent network representation of the  

discretized MoM problem. 
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The Momentum Solution Process  
 
Different steps and technologies enable the Momentum solution process:  

• Calculation of the substrate Green's functions  

• Meshing of the planar signal layer patterns  

• Loading and solving of the MoM interaction matrix equation  

• Calibration and de-embedding of the S-parameters  

• Reduced Order Modeling by Adaptive Frequency Sampling  

Calculation of the Substrate Green's Functions  
The substrate Green's functions are the spatial impulse responses of the substrate to Dirac 
type excitations. They are calculated for each pair of signal (strip, slot and/or via) layers 
mapped to a substrate level. Although it is necessary to know which signal layers are 
mapped to a substrate level, since only impulse responses are being calculated, it is not 
necessary to know the patterns on these signal layers. This implies that the Green's 
functions can be pre-calculated and stored in a substrate database. This allows the substrate 
Green's functions to be reused for other circuits defined on the same substrate.  
The high frequency electromagnetic Green's functions depend upon the radial distance and 
the frequency. The computations are performed up to very large radial distances over the 
entire frequency band specified by the user. The frequency points are selected adaptively to 
ensure an accurate interpolation with respect to frequency. Computations performed over 
very wide frequency ranges can consume more CPU time and disk space to store the results. 
To increase speed, the RF mode uses quasi-static electromagnetic functions based on low-
frequency approximation.  
Meshing of the Planar Signal Layer Patterns  
The planar metallization (strip, via) and aperture (slot) patterns defined on the signal layers 
are meshed with rectangular and triangular cells in the microwave simulation mode. As 
translational invariance can be used to speed up the interaction matrix load process, the 
meshing algorithm will maximize the number if uniform rectangular cells created in the 
mesh. The meshing algorithm is very flexible as different parameters can be set by the user 
(number of cells/wavelength, number of cells/width, edge meshing, and mesh seeding), 
resulting in a mesh with different density. It is clear that the mesh density has a high impact 
on both the efficiency and accuracy of the simulation results. Default mesh parameters are 
provided which give the best accuracy/efficiency trade-off. The RF mode uses mesh 
reduction technology to combine rectangular and triangular cells to produce a mesh of 
polygonal cells, thus reducing demand for computer resources.  
Loading and Solving of the MoM Interaction Matrix Equation  
The loading step of the solution process consists of the computation of all the 
electromagnetic interactions between the basis functions and the filling of the interaction 
matrix and the excitation vector. The interaction matrix as defined in the rooftop basis is a 
dense matrix, that is, each rooftop function interacts with every other rooftop function. This 
electromagnetic interaction between two basis functions can either be strong or weak, 
depending on their relative position and their length scale. The matrix filling process is 
essentially a process of order (N2), i.e. the computation time goes up with the square of the 
number of unknowns.  
In the solving step, the interaction matrix equation is solved for the unknown current 
expansion coefficients. The solution yields the amplitudes of the rooftop basis functions 
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which span the surface current in the planar circuit. Once the currents are known, the field 
problem is solved because all physical quantities can be expressed in terms of the currents. 
In Momentum, the matrix equation is solved with a standard matrix factorization technique. 
This implies that the matrix solve process is essentially a process of order (N3).  
Calibration and De-embedding of the S-parameters  
Momentum performs a calibration process on the single type port, the same as any accurate 
measurement system, to eliminate the effect of the sources connected to the transmission 
line ports in the S-parameter results. Feedlines of finite length are added to the transmission 
line ports of the circuit. Lumped sources are connected to the far end of the feedlines. These 
sources excite the eigenmodi of the transmission lines without interfering with the circuit. 
The effect of the feedlines is computed by the simulation of a calibration standard and 
subsequently removed from the S-parameter data. A built-in cross section solver calculates 
the characteristic impedance and propagation constant of the transmission lines. This allows 
to shift the phase reference planes of the S-parameters, a process called de-embedding. 
Results of the calibration process includes the elimination of low-order mode mismatches at 
the port boundary, elimination of high-order modes, and removal of all port excitation 
parasitics.  
Besides transmission line ports, Momentum offers the user the ability to define direct 
excitation or internal ports. These ports can be specified at any location on the planar 
metallization patterns as either a point or a line feed. They allow to connect both passive 
and active lumped components to the distributed model of the planar circuits. The S-
parameters associated with these ports are calculated from the excitation consisting of a 
lumped source connected to the equivalent network model at the locations of the internal 
ports. The parasitic effects of these lumped sources are not calibrated out of the S-
parameters results.  
Reduced Order Modeling by Adaptive Frequency Sampling  
A key element to providing fast, highly accurate solutions using a minimum of computer 
resources is the Adaptive Frequency Sampling (AFS) technology. When simulating over a 
large frequency range, oversampling and straight line interpolation can be used to obtain 
smooth curves for the S-parameters. Oversampling however implies a huge amount of 
wasted resources. Momentum allows the user to benefit from a smart interpolation scheme 
based on reduced order modeling techniques to generate a rational pole/zero model for the 
S-parameter data. The Adaptive Frequency Sampling algorithm selects the frequency 
samples automatically and interpolates the data using the adaptively constructed rational 
pole/zero model. This feature allows important details to be modeled by sampling the 
response of the structure more densely where the S-parameters are changing significantly. 
It minimizes the total number of samples needed and maximizes the information provided 
by each new sample. Typical types of structures where the AFS module is very helpful 
include:  

• Unmatched transmission line structures  

• Resonant structures, such as filters  

• Structures where unexpected coupling occurs  
In fact, nearly any kind of structure can take advantage of the AFS module. The Adaptive 
Frequency Sampling technology reduces the computation time needed for simulating large 
frequency ranges with Momentum significantly.  
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